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Safety information
Connect the power supply cord to a properly grounded electrical outlet that is near the product and easily accessible.

CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling connections, such
as the power supply cord or telephone, during a lightning storm.

Refer service or repairs, other than those described in the user documentation, to a professional service person.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.

This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

CAUTION—POTENTIAL INJURY:  Use the handholds on the sides of the printer to lift it, and make sure your
fingers are not under the printer when you set it down.

CAUTION—POTENTIAL INJURY: Do not twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If the power cord is misused, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of misuse. Remove the power cord from the electrical outlet before inspecting it.

CAUTION—SHOCK HAZARD: When accessing the system board, turn the printer off, and then unplug the power
cord from the wall outlet before continuing. If you have other devices attached to the printer, then turn them
off as well and unplug any cables going to the printer.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer, unplug
the power cord from the wall outlet and disconnect all cables from the printer before proceeding.

CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal injury
or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off of the optional drawer and set it aside instead of trying to lift the drawer and printer at the
same time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.

Safety information
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Learning about the printer

Printer configurations

Basic model
The following illustration shows the printer front with its basic features or parts:

1 Front door release button

2 Paper stop

3 Standard exit bin

4 Printer control panel

5 System board door

6 Standard 250-sheet tray (Tray 1)

7 Manual feeder door

8 Front door

The following illustration shows the printer back with its basic features or parts:

Learning about the printer
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1 Rear door

2 USB port

3 Parallel port

4 Printer power cord socket

5 Power button (On/Off switch)

6 Locking device

Configured models
The following illustration shows the printer configured with an optional 250-sheet drawer:

Learning about the printer
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1 Front door release button

2 Paper stop

3 Standard exit bin

4 Printer control panel

5 System board door

6 Standard 250-sheet tray (Tray 1)

7 Optional 250-sheet drawer (Tray 2)

8 Manual feeder door

9 Front door

The following illustration shows the printer configured with an optional 550-sheet drawer:

Learning about the printer

12
Download from Www.Somanuals.com. All Manuals Search And Download.



1 Front door release button

2 Paper stop

3 Standard exit bin

4 Printer control panel

5 System board door

6 Standard 250-sheet tray (Tray 1)

7 Optional 550-sheet drawer (Tray 2)

8 Manual feeder door

9 Front door

Understanding the printer control panel
The printer control panel features six lights and two buttons.

Learning about the printer
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Item

1 Error light

2 Jam light

3 Load paper light

4 Toner light

5 Ready light

6 Continue button

7 Stop button

Attaching cables
1 Connect the printer to a computer using USB or parallel cable.

2 Connect the power cord to the printer first and then to a wall outlet.

Learning about the printer
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1 USB port

2 Parallel port

3 Printer power cord socket

Learning about the printer
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Understanding the printer menus
A number of menus are available to make it easy for you to change the printer settings. You may print a menus list
by printing the menu settings page. From a printer connected by USB or parallel cable, access the menus by using
the Local Printer Settings Utility for Microsoft® Windows® or Printer Settings for Macintosh®.

Paper menu

Default Source menu

Menu item Description

Default Source
Tray <x>
Manual Paper
Manual Env

Sets a default paper source for all print jobs

Notes:

• Tray 1 (standard tray) is the factory default setting.

• Only an installed paper source will appear as a menu setting.

• A paper source selected for a print job overrides the Default Source setting
for the duration of the print job.

• If the same size and type of paper are in two trays and the Paper Size and
Paper Type settings match, the trays are automatically linked. When one
tray is empty, the job prints using paper from the linked tray.

Size/Type menu

Menu item Description

Select Source menu
Tray 1
Tray 2
Manual Paper
Manual Envelope

Notes:

• These menus let you specify the installed paper size and type in the
selected tray or manual feeder.

• Only installed trays and feeders are listed in this menu.

Set Size menu for Tray 1 or Tray 2
A4
A5
A6
JIS B5
Executive
Folio
Legal
Letter
Oficio (Mexico)
Statement
Universal

Lets you specify the paper size loaded in each tray

Notes:

• Letter is the US factory default setting. A4 is the international factory
default setting.

• If the same size and type of paper are in two trays and the Paper Size and
Paper Type settings match, then the trays are automatically linked. When
one tray is empty, the job prints using paper from the linked tray.

• The A6 paper size is supported only in Tray 1.

Understanding the printer menus
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Menu item Description

Set Size menu for Manual Paper
A4
A5
Executive
Folio
JIS B5
Legal
Letter
Oficio (Mexico)
Statement
Universal

Lets you specify the size of the paper being loaded in the manual feeder

Note: Letter is the US factory default setting. A4 is the international factory
default setting.

Set Size menu for Manual Envelope
7 3/4 Envelope
9 Envelope
10 Envelope
C5 Envelope
B5 Envelope
DL Envelope
Other Envelope

Lets you specify the size of the envelope being manually loaded

Note: 10 Envelope is the US factory default setting. DL Envelope is the
international factory default setting.

Set Type menu for Tray 1
Plain Paper
Card Stock
Transparency
Recycled
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Lets you specify the type of paper loaded in Tray 1

Notes:

• Plain Paper is the factory default setting for Tray 1.

• If available, a user-defined name will appear instead of Custom Type <x>.

• Use this menu item to configure automatic tray linking.

Set Type menu for Tray 2
Plain Paper
Card Stock
Recycled
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Lets you specify the type of paper loaded in Tray 2

Notes:

• Custom Type <x> is the factory default setting.

• If available, a user-defined name will appear instead of Custom Type <x>.

• Use this menu item to configure automatic tray linking.

Understanding the printer menus
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Menu item Description

Set Type menu for Manual Paper
Plain Paper
Card Stock
Transparency
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Lets you specify the type of paper being manually loaded

Note: Plain Paper is the factory default setting.

Set Type menu for Manual
Envelope

Envelope
Custom Type <x>

Lets you specify the type of envelope being manually loaded

Note: Envelope is the factory default setting.

Paper Texture menu
In the Paper Texture menu, the Select Type and Select Texture features work together to enable you to select the
texture for a specific type of paper.

Menu item Description

Select Type
Plain Texture
Card Stock Texture
Transparency Texture
Recycled Texture
Bond Texture
Envelope Texture
Letterhead Texture
Preprinted Texture
Colored Texture
Light Texture
Heavy Texture
Rough Texture
Custom <x> Texture

Specifies the paper type

Understanding the printer menus
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Menu item Description

Select Texture
Smooth
Normal
Rough

After you select a setting for Select Type, the Select Texture feature lets you
set the texture for that type of media.

Notes:

• Normal is the factory default setting for most items.

• Rough is the factory default setting for Bond.

• When Rough Texture is the setting selected for Select Type, Rough is the
only Select Texture setting available.

• Settings appear only if the paper is supported.

Paper Weight menu
In the Paper Weight menu, the Select Type and Select Weight features work together to enable you to select the
weight for a specific type of paper.

Menu item Description

Select Type
Plain Weight
Card Stock Weight
Transparency Weight
Recycled Weight
Bond Weight
Envelope Weight
Letterhead Weight
Preprinted Weight
Colored Weight
Light Weight
Heavy Weight
Rough Weight
Custom <x> Texture

Specifies the paper type

Select Weight
Light
Normal
Heavy

After you select a setting for Select Type, the Select Weight feature
lets you set the weight for that type of media.

Notes:

• Normal is the factory default setting for most items.

• When Light Weight is the setting selected for Select Type, Light
is the only Select Weight setting available.

• When Heavy Weight is the setting selected for Select Type, Heavy
is the only Select Weight setting available.

• Settings appear only if the paper is supported.

Understanding the printer menus
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Paper Loading menu

Menu item Description

Select Type
Recycled Loading
Bond Loading
Letterhead loading
Preprinted Loading
Colored Loading
Light Loading
Heavy Loading
Custom Loading

Specifies the paper type

Note: After you select the type of paper, the Set Loading menu
appears.

Set Loading
• Duplex

• Off

Specifies whether duplex (2-sided) printing is turned on

Note: Off is the factory default setting.

Custom Types menu

Menu item Description

Custom Type <x>
Paper
Card Stock
Transparency
Envelope
Rough/Cotton

Name a Custom Type <x>, and this user-defined name displays instead of
Custom Type <x>.

Notes:

• The Custom Name must be limited to 16 characters.

• Paper is the factory default setting for the Custom Type.

• The custom media type must be supported by the selected tray or feeder
in order for you to print from that source.

Recycled
Paper
Card Stock
Transparency
Envelope
Rough/Cotton

Assign a paper type for the Recycled paper type loaded, and it will also be the
Recycled paper type in other menus.

Notes:

• Paper is the factory default setting.

• The Recycled type must be supported by the selected tray or feeder in
order for you to print from that source.

Understanding the printer menus

20
Download from Www.Somanuals.com. All Manuals Search And Download.



Universal Setup menu
These menu items are used to specify the height, width, and feed direction of the Universal Paper Size. The Universal
Paper Size is a user-defined paper size. It is listed with the other paper size settings and includes similar options, such
as support for duplex printing and printing multiple pages on one sheet.

Menu item Description

Units of Measure
Inches
Millimeters

Identifies the units of measure

Notes:

• Inches is the US factory default setting.

• Millimeters is the international factory default setting.

Portrait Width
3–14.17 inches
76–360 mm

Sets the portrait width

Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the US factory default setting. Inches can be increased
in 0.01-inch increments.

• 216 mm is the international factory default setting. Millimeters can
be increased in 1-mm increments.

Portrait Height
3–14.17 inches
76–360 mm

Sets the portrait height

Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the US factory default setting. Inches can be increased in
0.01-inch increments.

• 356 mm is the international factory default setting. Millimeters can
be increased in 1-mm increments.

Feed Direction
Short Edge
Long Edge

Specifies the feed direction

Notes:

• Short Edge is the factory default setting.

• Long Edge appears only if the longest edge is shorter than the
maximum length supported in the tray.

Understanding the printer menus
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USB menu
Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job received
through a USB port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if the PS
Smartswitch setting is On. It uses the default printer language specified in the
Setup menu if the PS SmartSwitch setting is Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PostScript emulation when a print job
received through a USB port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if the PCL
Smartswitch setting is On. It uses the default printer language specified in the
Setup menu if the PCL SmartSwitch setting is Off.

NPA Mode
On
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting automatically resets the printer.

USB Buffer
Disabled
Auto
3K to <maximum size allowed>

Sets the size of the USB input buffer

Notes:

• Auto is the factory default setting.

• The Disabled setting turns off job buffering. Any jobs already buffered are
printed before normal processing is resumed.

• The USB buffer size value can be changed in 1 K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether the Resource Save setting is On
or Off.

• To increase the maximum size range for the USB Buffer, disable or reduce the
size of the parallel buffer.

• Changing this setting automatically resets the printer.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.

Understanding the printer menus
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Parallel menu
Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job received
through a parallel port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PostScript emulation when a print job
received through a parallel port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if PCL SmartSwitch
is set to On. It uses the default printer language specified in the Setup menu if
PCL SmartSwitch is set to Off.

NPA Mode
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting automatically resets the printer.

Parallel Buffer
Disabled
Auto
3K to <max size allowed>

Sets the size of the parallel input buffer

Notes:

• Auto is the factory default setting.

• The Disabled setting turns off job buffering. Any jobs already buffered on the
disk are printed before normal processing is resumed.

• The parallel buffer size setting can be changed in 1 K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or Off.

• To increase the maximum size range for the Parallel Buffer, disable or reduce
the size of the USB buffer.

• Changing this setting automatically resets the printer.

Advanced Status
Off
On

Enables bidirectional communication through the parallel port

Notes:

• On is the factory default setting.

• The Off setting disables parallel port negotiation.

Understanding the printer menus
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Menu item Description

Protocol
Standard
Fastbytes

Specifies the parallel port protocol

Notes:

• Fastbytes is the factory default setting. It provides compatibility with most
existing parallel ports and is the recommended setting.

• The Standard setting tries to resolve parallel port communication problems.

Honor Init
On
Off

Determines whether the printer honors printer hardware initialization requests from
the computer

Notes:

• Off is the factory default setting.

• The computer requests initialization by activating the INIT signal from the
parallel port. Many personal computers activate the INIT signal each time the
computer is turned on and off.

Parallel Mode 2
On
Off

Determines whether the parallel port data is sampled on the leading (on) or trailing
(off) edge of the strobe.

Note: On is the factory default setting.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.

Settings menu

General Settings menu

Menu item Description

Eco-Mode
Off
Energy
Paper
Energy/Paper

Note: Off is the factory default setting.

Quiet Mode
Off
On

Note: Off is the factory default setting.

Run Initial Setup
Yes
No

Before running the Setup wizard, the default setting is Yes, but
after running the wizard, the default setting is No.

Understanding the printer menus
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Menu item Description

Alarm
Cartridge Alarm

Off
Single

The display shows a message when the toner is low.

Notes:

• Off is the factory default setting. The Toner is low
message will appear as a warning.

• Single means the Toner is low message will appear and
the indicator light will blink red.

Timeouts
Power Saver

Disabled
1–240

Sets the amount of time in minutes the printer waits after a job is
printed before it goes into a reduced power state

Notes:

• 60 minutes is the factory default setting.

• Disabled does not appear unless Energy Conserve is Off.

Timeouts
Print Timeout

Disabled
1–255

Sets the amount of time in seconds the printer waits to receive an
end-of-job message before canceling the remainder of the print
job

Notes:

• 90 seconds is the factory default setting.

• When the timer expires, any partially printed page still in the
printer is printed, and then the printer checks to see if any new
print jobs are waiting.

• Print Timeout is available only when using PCL. This setting
has no effect on PostScript emulation print jobs.

Timeouts
Wait Timeout

Disabled
15–65535

Sets the amount of time in seconds the printer waits for additional
data before canceling a print job

Notes:

• 40 seconds is the factory default setting.

• Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL
emulation print jobs.

Print Recovery
Auto Continue

Disabled
5–255

Lets the printer automatically continue printing from certain
offline situations when not resolved within the specified time
period

Notes:

• Disabled is the factory default setting.

• 5–255 is a range of time in seconds.

Print Recovery
Jam Recovery

On
Off
Auto

Specifies whether the printer reprints jammed pages

Notes:

• Auto is the factory default setting. The printer reprints jammed
pages unless the memory required to hold the pages is
needed for other printer tasks.

• On sets the printer to always reprint jammed pages.

• Off sets the printer to never reprint jammed pages.
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Menu item Description

Print Recovery
Page Protect

On
Off

Lets the printer successfully print a page that may not have printed
otherwise

Notes:

• Off is the factory default setting. Off prints a partial page when
there is not enough memory to print the whole page.

• On sets the printer to process the whole page so that the entire
page prints.

Factory Defaults
Do Not Restore
Restore Now

Returns the printer settings to the factory default settings

Notes:

• Do Not Restore is the factory default setting. Do Not Restore
keeps the user-defined settings.

• Restore Now returns all printer settings to the factory default
settings except those in the USB and parallel menu. All
downloads stored in RAM are deleted.

Setup menu

Menu item Description

Printer Language
PS Emulation
PCL Emulation

Sets the default printer language

Notes:

• PostScript emulation uses a PS interpreter for processing print
jobs. PCL emulation uses a PCL interpreter for processing print
jobs.

• The factory default printer language is PCL Emulation.

• Setting a printer language as the default does not prevent a
software program from sending print jobs that use another
printer language.

Print Area
Normal
Whole Page

Sets the logical and physical printable area

Notes:

• Normal is the factory default setting. When attempting to
print data in the non-printable area defined by the Normal
setting, the printer clips the image at the boundary.

• The Whole Page setting allows the image to be moved into
the non-printable area defined by the Normal setting, but the
printer will clip the image at the Normal setting boundary.

• The Whole Page setting affects only pages printed using a
PCL 5e interpreter. This setting has no effect on pages printed
using the PCL XL or PostScript interpreter.

Download Target
RAM

Sets the storage location for downloads

Notes:

• RAM is the factory default setting.

• Storing downloads in RAM is temporary.
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Menu item Description

Resource Save
On
Off

Specifies how the printer handles temporary downloads, such as
fonts and macros stored in RAM, when the printer receives a job
that requires more memory than is available

Notes:

• Off is the factory default setting. Off sets the printer to retain
the downloads only until memory is needed. Downloads are
deleted to process print jobs.

• The On setting retains the downloads during language
changes and printer resets. If the printer runs out of memory,
then downloads are not deleted.

Print All Order
Alphabetically
Newest First
Oldest First

Sets the order in which the print jobs are printed.

Note: Alphabetically is the factory default setting.

Finishing menu

Menu item Description

Sides (Duplex)
2-sided
1-sided

Specifies whether duplex (2-sided) printing is set as the default for all print jobs

Notes:

• 1-sided is the factory default setting.

• To set 2-sided printing from the software program, for Windows users, click
File  Print, and then click Properties, Preferences, Options, or Setup. For
Macintosh users, choose File > Print, and then adjust the settings from the
print dialog and pop-up menus.

Duplex Binding
Long Edge
Short Edge

Defines the way duplexed pages are bound and how the printing on the back of
the page is oriented in relation to the printing on the front of the page

Notes:

• Long Edge is the factory default setting.

• Long Edge specifies that binding be placed on the left edge of portrait pages
and the top edge of landscape pages.

• Short Edge specifies that binding be placed on the top edge of portrait pages
and the left edge of landscape pages.

Copies
1–999

Specifies a default number of copies for each print job

Note: 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specifies whether blank pages are inserted in a print job

Note: Do Not Print is the factory default setting.
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Menu item Description

Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stacks the pages of a print job in sequence when printing multiple copies

Notes:

• On is the factory default setting, so the pages will be printed sequentially.

• Both settings print the entire job the same number of times.

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Specifies whether blank separator sheets are inserted

Notes:

• None is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if Collate
is On. If Collation is Off, a blank page is inserted between each set of printed
pages, such as after all page 1s and after all page 2s.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or inserting blank pages in a
document for notes.

Separator Source
Tray <x>
Multi-Purpose Feeder

Specifies the paper source for separator sheets

Notes:

• Tray 1 (standard tray) is the factory default setting.

• Multi-Purpose Feeder appears as a value only if it is a supported option on the
printer and if Configure MP is set to Cassette.

N-up (pages-side)
Off
2-Up
3-Up
4-Up
6-Up
9-Up
12-Up
16-Up

Specifies that multiple-page images be printed on one side of a sheet of paper.

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per side.

N-up Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specifies the positioning of multiple-page images when using N-up (pages-sides)

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of images and whether the images are in
portrait or landscape orientation.

Orientation
Auto
Landscape
Portrait

Specifies the orientation of a multiple-page sheet

Notes:

• Auto is the factory default setting. The printer chooses between portrait and
landscape.

• Landscape uses long edge.

• Portrait uses short edge.
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Menu item Description

N-up Border
None
Solid

Prints a border around each page image when using N-up (pages-sides)

Note: None is the factory default setting.

Quality menu

Menu item Description

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 IQ
2400 IQ

Specifies the printed output resolution

Note: 600 dpi is the factory default setting.

Toner Darkness
1–10

Lightens or darkens the printed output

Notes:

• 8 is the factory default setting.

• Selecting a smaller number can help conserve toner.

Enhance Fine Lines
On
Off

Enables a print mode preferable for files such as architectural drawings, maps,
electrical circuit diagrams, and flow charts

Notes:

• Off is the factory default setting.

• To set Enhance Fine Lines, with a document open, click File  Print, and then
click Properties, Preferences, Options, or Setup for Windows users. For
Macintosh users, choose File> Print, and then adjust the settings from the print
dialog and pop-up menus.

Gray Correction
Auto
Off

Choose whether to apply Gray Correction on printed gray images. The Auto setting
automatically applies Gray Correction, and Off does not.

Note: Off is the factory default setting.

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both directions

Choose whether to make characters more distinct and definite. Pixel Boost may be
needed when using certain fonts.

Note: Off is the factory default setting.

Brightness
-6–6

Adjusts or darkens printed output and conserves toner

Note: 0 is the factory default setting.

Contrast
0–5

Adjusts the contrast of printed objects

Note: 0 is the factory default setting.
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PostScript menu

Menu item Description

Print PS Error
On
Off

Prints a page containing the PostScript error

Note: Off is the factory default setting.

Font Priority
Resident
Flash/Disk

Establishes the font search order

Notes:

• Resident is the factory default setting.

• A formatted flash memory option card must be installed in the printer and
operating properly for this menu item to be available.

• The flash memory option cannot be Read/Write, Write, or
password-protected.

• Job Buffer Size must not be set to 100%.

PCL Emul menu

Menu item Description

Font Source
Resident
Download
Flash
All

Specifies the set of fonts available

Notes:

• Resident is the factory default setting. It shows the factory default set of
fonts downloaded into RAM.

• Download appears only if downloaded fonts exist. It shows all the fonts
downloaded into RAM.

• Flash appears only if a flash option containing fonts is installed.

• A flash option must be properly formatted and cannot be Read/Write,
Write, or password protected.

• All shows all fonts available to any option.

Font Name
<x>

Lets you view or change the setting from a selection list

Symbol Set
<x>

Lets you view or change the setting from a selection list

PCL Emulation Settings
Point Size

1.00–1008.00

Changes the point size for scalable typographic fonts

Notes:

• 12 is the factory default setting.

• Point Size refers to the height of the characters in the font. One point equals
approximately 1/72 of an inch.

• Point sizes can be increased or decreased in 0.25-point increments.
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Menu item Description

PCL Emulation Settings
Pitch

0.08–100

Specifies the font pitch for scalable monospaced fonts

Notes:

• 10 is the factory default setting.

• Pitch refers to the number of fixed-space characters per inch (cpi).

• Pitch can be increased or decreased in 0.01-cpi increments.

• For nonscalable monospaced fonts, the pitch appears on the display but
cannot be changed.

PCL Emulation Settings
Orientation

Portrait
Landscape

Specifies the orientation of text and graphics on the page

Notes:

• Portrait is the factory default setting.

• Portrait prints text and graphics parallel to the short edge of the page.

• Landscape prints text and graphics parallel to the long edge of the page.

PCL Emulation Settings
Lines per Page

1–255
60
64

Specifies the number of lines that print on each page

Notes:

• 60 is the US factory default setting. 64 is the international default setting.

• The printer sets the amount of space between each line based on the Lines
per Page, Paper Size, and Orientation settings. Select the desired Paper Size
and Orientation before setting Lines per Page.

PCL Emulation Settings
A4 Width

198 mm
203 mm

Sets the printer to print on A4-size paper

Notes:

• 198 mm is the factory default setting.

• The 203-mm setting sets the width of the page to allow the printing of
eighty 10-pitch characters.

PCL Emulation Settings
Auto CR after LF

On
Off

Specifies whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR

On
Off

Specifies whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command

Note: Off is the factory default setting.
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Menu item Description

Tray Renumber
Assign MP Feeder

Off
None
0–199

Assign Tray <x>
Off
None
0–199

Assign Manual Paper
Off
None
0–199

Assign Man Env
Off
None
0–199

Configures the printer to work with printer software or programs that use
different source assignments for trays, drawers, and feeders

Notes:

• Off is the factory default setting.

• None is not an available selection. It is displayed only when it is selected
by the PCL 5 interpreter.

• None ignores the Select Paper Feed command.

• 0–199 allows a custom setting to be assigned.

Tray Renumber
View Factory Def

None

Displays the factory default setting assigned to each tray, drawer, or feeder

Tray Renumber
Restore Defaults

Yes
No

Returns all tray, drawer, and feeder assignments to the factory default settings

Using the Finishing menu
Use the Finishing menu to adjust settings for such features as Collate, Separator Sheets, and N-up (Multipage) printing.
You can use the settings to collate pages, to insert separator sheets between print jobs, and to print up to 16 images
on a single page.

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows
or Printer Settings for Macintosh. One of these utilities installs with the printer software.
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Additional printer setup

Installing internal options

Accessing the system board to install internal options
CAUTION—SHOCK HAZARD: When accessing the system board, turn the printer off, and then unplug the power
cord from the wall outlet before continuing. If you have other devices attached to the printer, then turn them
off as well and unplug any cables going to the printer.

1 As you face the printer, the system board door is on the right side. Open the system board door.

2 Use the following illustration to locate the appropriate connector.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any system board electronic components or connectors.

1 USB port

2 Parallel connector

3 Memory card connector
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Installing a memory card
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch
a metal surface on the printer before touching any system board electronic components or connectors.

An optional memory card can be purchased separately and attached to the system board. To install the memory
card:

1 Turn the printer off.

2 Access the system board.

3 Unpack the memory card.

Note: Avoid touching the connection points along the edge of the card.

4 Align the memory card with its connector on the system board.

5 Push open the latches on both ends of the memory connector.

Warning—Potential Damage: Memory cards are easily damaged by static electricity. Touch a grounded metal
surface before you touch a memory card.

Note: Memory cards designed for other printers may not work with your printer.
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6 Push the memory card into the connector until the latches snap into place.

It may require some force to fully seat the card.

7 Ensure that each latch fits over the notch on each end of the card.

8 Close the system board door.

9 Turn the printer back on.

10 In Windows Vista®:

a Click  Control Panel.

b Click Hardware and Sound.

c Click Printers.
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In Windows® XP and 2000:

a Click Start  Control Panel.

b Double-click Printers and Other Hardware.

c Double-click Printers and Faxes.

11 Right-click the Dell 2230d Laser Printer icon.

12 Click Properties.

13 Click Install Options.

Note: Memory cards designed for other printers may not work with your printer.

14 Click Ask Printer.

15 Click OK.

16 Click OK, and then close the Printers folder.

Installing hardware options

Installing a 250- or 550-sheet drawer
An optional drawer attaches under the printer. A drawer consists of two parts: a tray and a support unit. The printer
supports one optional drawer; you can install a 250- or 550-sheet drawer.

CAUTION—SHOCK HAZARD: If you are installing a drawer after setting up the printer, turn off the printer, and
unplug the power cable before continuing.

1 Turn the printer off.

2 Unpack the drawer, and remove any packing material.

3 Remove the tray from the support unit.

1 Support unit

2 Tray

4 Remove any packing material and tape from inside the tray.

Additional printer setup

36
Download from Www.Somanuals.com. All Manuals Search And Download.



5 Insert the tray into the support unit.

6 Place the drawer in the location chosen for the printer.

7 Align the holes in the printer with the positioning posts on the drawer, and lower the printer into place.

8 Turn the printer back on.

9 In Windows Vista®:

a Click  Control Panel.

b Click Hardware and Sound.

c Click Printers.

In Windows® XP and 2000:

a Click Start  Control Panel.

b Double-click Printers and Other Hardware.

c Double-click Printers and Faxes.

10 Right-click the Dell 2230d Laser Printer icon.

11 Click Properties.

12 Click Install Options.

13 Click Ask Printer.

14 Click OK.

15 Click OK, and then close the Printers folder.
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Printing the printer settings configuration sheet
The printer settings configuration sheet shows the current configuration settings. It also provides instructions on
how to navigate through the configuration menus to select and save new settings. To print the printer settings
configuration sheet:

1 Turn the printer off.

2 Open the front door.

3 Press and hold  as you turn the printer on.

All the lights cycle.

4 Release .

5 Close the front door.

The light sequence representing the home menu appears.

Home Menu

 - On

 - On

 - On

 - On

6 Press  until all the lights cycle.

The printer settings configuration sheet prints.

Note: The sheet prints only when the home menu light sequence is on.
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Interpreting the printer control panel
lights

Understanding the printer control panel light
sequences

Understanding the primary light sequences

Printer control panel Lights and buttons

1 Error

2 Jam

3 Load paper

4 Toner

5 Ready

6 Continue

7 Stop

The printer control panel features six lights and two buttons. The lights can be on, off, blinking, or blinking slowly.

Light sequence What you can do

Service Error

 - Blinking

 - Blinking

 - Blinking

 - Blinking

 - Blinking

 - Blinking

Turn the printer off and then on
again. If the lights are still blinking,
contact Dell at support.dell.com.
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Light sequence What you can do

Replace PC Kit

 - Blinking

 - Blinking

 - On

Replace the photoconductor kit.
For more information, see
“Replacing the photoconductor
kit” on page 91.

Ready

 - On (green)

Send a job to print.

Power Saver

 - On (yellow)

Send a job to print.
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Light sequence What you can do

Hex Trace Ready

 - Slowly Blinking

Use Hex Trace to troubleshoot
printing problems.

Busy

 - Blinking

Wait or press .

Flushing Buffer

 - Blinking

 - Blinking

Wait until the printer returns to the
Ready state.
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Light sequence What you can do

Waiting

 - On

 - On

Wait for the light sequence to clear.

Canceling job

 - On

 - On

 - On

 - On

 - On  - On

Wait for the light sequence to clear.

Invalid Engine Code

 - On

 - On

Press and release . To avoid this
light sequence in the future,
ensure that you use a valid code
when programming the printer.
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Light sequence What you can do

Not ready

 - On

Press and release either  or l
to return to the Ready state.

Cartridge region mismatch

 - On

 - On

Replace the toner cartridge with
one suitable for your region. For
more information, see “Replacing
the toner cartridge” on page 89.

Front door is open

 - On

Close the front door.
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Light sequence What you can do

No paper in Tray 1 or Tray 2

 - On

 - On

Load paper in Tray 1 or Tray 2.

No paper in manual feeder

 - On

Load paper in the manual feeder.

Remove paper from the standard exit bin

 - Blinking

Remove printed pages from the
standard exit bin, and then press
and release  to clear the light
sequence and continue printing.
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Light sequence What you can do

Cartridge is low

 - On

 - On

• Press and release  to clear
the light sequence and
continue processing the print
job.

• With the printer turned off,
remove the toner cartridge
and shake it to extend its life.

• Replace the toner cartridge,
and then turn the printer on.
For more information, see
“Replacing the toner cartridge”
on page 89.

PC Kit life warning

 - Blinking

 - On

• Press and release  to clear
the light sequence and
continue processing the print
job.

• Replace the photoconductor
kit. For more information, see
“Replacing the
photoconductor kit” on
page 91.

The following light sequences show that there is a secondary error code or secondary jam code to read:

Light sequence What you can do

Printer error

 - On  - On

Press  twice quickly to see the
secondary error code. For more
information, see “Understanding the
secondary error light sequences” on
page 46.
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Light sequence What you can do

Paper jam

 - On

 - On

Press  twice quickly to see the
secondary paper jam code. For more
information, see “Understanding the
secondary paper jam light sequences” on
page 50.

Understanding the secondary error light sequences
When the  and  lights are on simultaneously, press  twice quickly to see the secondary error code.

Printer control panel Lights and buttons

1 Error

2 Jam

3 Load paper

4 Toner

5 Ready

6 Continue

7 Stop
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Light sequences What you can do

Complex page, some data may not have printed

 - On

 - On

 - On

• Simplify the page by reducing
the amount of text, graphics,
fonts, or macros.

• Set Page Protect to On.

• Print the page that may not have
printed. For more information,
see “Print Recovery” on
page 26.

• Install additional printer
memory. For more information,
see “Installing a memory card”
on page 34.

Insufficient memory to collate job

 - On

 - On

 - On

• Press  to collate the remaining
pages of the job.

• Press  to cancel the print job.

• Simplify the page by reducing
the amount of text, graphics,
fonts, or macros.

• Install additional printer
memory. For more information,
see “Installing a memory card”
on page 34.

Insufficient memory to support Resource Save feature

 - On

 - Blinking

 - On

Install additional printer memory.
For more information, see
“Installing a memory card” on
page 34

Interpreting the printer control panel lights

47
Download from Www.Somanuals.com. All Manuals Search And Download.



Light sequences What you can do

Host interface disabled

 - On  - Blinking

 - Blinking

 - On

Press  to clear the code. The
printer discards any print jobs
previously sent.

Memory full

 - On

 - On

 - On

 - On

• Press  to clear the message
and continue the print job.

• Press and release  to cancel
the print job.

• Press and hold  to reset the
printer.

• To avoid this error in the future,
simplify the print job. Reduce
the complexity of the page by
reducing the amount of text or
graphics on the page and
deleting unnecessary
downloaded fonts or macros.

• Install additional printer
memory. For more information,
see “Installing a memory card”
on page 34.

Paper size is small

 - On

 - On

 - On

 - On

• Ensure that the paper you
loaded is large enough.

• Clear any paper jam.

• Press  to clear the code and
continue the print job.
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Light sequences What you can do

Invalid engine code

 - On

 - On

 - On

Download valid engine code to the
internal print server.

Cartridge region mismatch

 - On

 - Blinking

 - On

Replace the toner cartridge with
one that is suitable for your region.
For more information, see
“Replacing the toner cartridge” on
page 89.

Invalid refill, Change cartridge

 - On

 - Blinking

 - On

Replace the toner cartridge. For
more information, see “Replacing
the toner cartridge” on page 89.
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Light sequences What you can do

Replace missing or defective cartridge

 - On

 - Blinking

 - On

Replace the toner cartridge. For
more information, see “Replacing
the toner cartridge” on page 89.

Cartridge part number not supported by device

 - On

 - On

 - On

Remove the toner cartridge and
replace it with a supported toner
cartridge. For more information, see
“Replacing the toner cartridge” on
page 89.

Understanding the secondary paper jam light sequences
When the  and  lights are on, a paper jam has occurred. Press and release  twice quickly to display the secondary
jam light sequence which can help pinpoint the site of the jam. Be sure to check all areas of the printer to ensure all
the paper is removed. Once the jam is cleared, press  to continue printing.

Printer control panel Lights and buttons

1 Error

2 Jam

3 Load paper

4 Toner

5 Ready

6 Continue

7 Stop
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Secondary paper jam sequences on the printer control panel

Light sequence What you can do to access the jam

200.yy Paper jam

 - On

 - On

 - On

Try one or more of the following:

• Remove Tray 1.

• Remove the photoconductor kit and toner
cartridge unit.

201.yy Paper jam

 - On

 - On

 - On

Remove the photoconductor kit and toner
cartridge unit.

202.yy Paper jam

 - On

 - On

 - On

Open the front door, and then open the rear
door.
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Light sequence What you can do to access the jam

231.yy Paper jam

 - On

 - Blinking

 - On

Open the front door, and then open the rear
door.

233.yy Paper jam

 - On

 - Blinking

 - Blinking

 - On

Try one or more of the following:

• Remove Tray 1.

• Open the front door, and then open the rear
door.

234.yy Paper jam

 - On

 - Blinking

 - On

Try one or more of the following:

• Remove Tray 1.

• Open the front door, and then open the rear
door.
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Light sequence What you can do to access the jam

235.yy Paper jam

 - On

 - Blinking

 - Blinking

 - On

Try one or more of the following:

• Clear the jam at the standard exit bin.

• Load paper supported by the duplex
function. For more information, see “Paper
sizes supported by the printer” on
page 68.

24x.yy Paper jam

 - On

 - On

 - On

 - On

Try one or more of the following:

• Remove Tray 1.

• Remove the photoconductor kit and toner
cartridge unit.

• Remove Tray 2.

24x.yy Paper jam

 - On

 - On

 - On

 - On

Try one or more of the following:

• Remove Tray 1.

• Remove the photoconductor kit and toner
cartridge unit.

• Remove Tray 2.
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Light sequence What you can do to access the jam

251.yy Paper jam

 - On

 - On

 - On

 - On

Clear the paper jam from the manual feeder.

Note: For more information, see “Clearing jams” on page 97.
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Loading paper and specialty media
This section explains how to load the 250- and 550-sheet trays, and the manual feeder. It also includes information
about setting the paper size and paper type.

Setting the paper size and paper type
Ensure that the settings for the trays reflect the size and type of paper loaded in the trays. The factory default paper
type setting is plain paper, so the paper type setting must be set manually for all trays that do not contain plain paper.

If the printer is connected to a computer by a USB or parallel cable, use one of the following utilities to access the
Paper menu, depending on your operating system:

• On a Windows computer, access the Paper menu through the Local Printer Settings Utility.

• On a Macintosh computer, access the Paper menu through the Printer Settings.

Note: The Paper Size and Type settings will be saved until you reset factory default settings. If you would like to
override the Paper Size and Type settings for a special print job, do one of the following:
• For Windows users, click File  Print, and then click Properties, Preferences, Options, or Setup.

• For Macintosh users, choose File > Print, and then adjust the settings from the print dialog and pop-up menus.

Configuring Universal paper settings
The Universal Paper Size is a user-defined setting that lets you print on paper sizes that are not preset in the printer
menus. Defining a specific height and width measurement for the Universal paper size, in the portrait orientation,
allows the printer to support the size. Specify all of the following Universal size settings for your paper:

• Units of measure (inches or millimeters)

• Portrait Width

• Portrait Height

Note: The smallest supported Universal size is 76.2 x 127 mm (3  x 5 in.); the largest is 216 x 356 mm (8.5 x 14 in.).

• If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for
Windows or Printer Settings for Macintosh. One of these utilities installs with your printer software. Under the
Paper menu, select Universal in the Paper Size selection box for the tray that will contain the Universal paper.

Loading the standard 250-sheet tray
The printer has two trays to select from: the standard tray (Tray 1), also known as the 250-sheet tray, and either the
optional 250-sheet tray or the optional 550-sheet tray (Tray 2). Only one optional drawer (which includes an optional
tray) may be attached to the printer at a time.
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Proper paper loading prevents jams and facilitates trouble-free printing.

1 Pull the tray completely out.

Do not remove trays while a job prints or when the Busy light sequence appears on the printer control panel.
Doing so may cause a jam.

Busy

 - Blinking

2 Squeeze the width guide tabs, and then slide them to the sides of the tray. The width guides move in unison.

3 Squeeze the length guide tabs together, and then slide the length guide to the correct position for the paper size
being loaded.
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If you are loading a longer size of paper like A4 or legal, squeeze the length guide tabs and slide the length guide
backwards to the position for the length of paper you are loading. The tray extends backwards.

If you are loading A6-size paper:

a Squeeze the length guide tabs together as shown, and slide the length guide toward the center of the tray
to the A6 size position.

b Raise the A6 length guide.

Note: The standard tray accommodates only 150 sheets of A6-size paper.

4 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.

5 Load the paper stack toward the back of the tray as shown with the recommended print side facedown.

Note: Notice the maximum fill line. Do not try to overload the tray. Do not load A6-size paper to the maximum
fill line; the tray holds only 150 sheets of A6-size paper.
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1 Maximum fill line

Note: When loading letterhead, place the top edge of the sheet toward the front of the tray. Load the letterhead
with the design placed facedown.

6 Squeeze the width guide tabs on the right guide, and slide the width guides to lightly touch the side of the stack.
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7 Insert the tray.

8 If a different type of paper was loaded than the type previously loaded in the tray, change the Paper Type setting.
For more information, see “Setting the paper size and paper type” on page 55.

Note: The difference between the standard 250-sheet tray and the optional 250- and 550-sheet trays is that the
standard tray accommodates up to 150 sheets of A6-size paper, so the width guides slide farther to the center of the
tray.

Loading the optional 250- or 550-sheet tray
Only one optional drawer, which includes either a 250- or 550-sheet tray, may be attached to the printer at a time.
Regardless of the number of sheets in the optional tray, it is referred to as Tray 2.

1 Pull the tray completely out.

2 See “Loading the standard 250-sheet tray” on page 55 to complete the steps for loading a tray. An optional tray
is loaded in the same way that the standard tray is loaded.
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3 Insert the tray.

Using the manual feeder
The manual feeder is located inside the manual feeder door of the printer and can feed only one sheet of paper at a
time. You can use the manual feeder to quickly print on paper types or sizes that are not currently loaded in the tray.

1 Open the manual feeder door.
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2 When the  light is lit, load the paper faceup into the center of the manual feeder.

Notes:

• Load letterhead faceup, with the top of the sheet entering first.

• Load envelopes with the flap side down and with the stamp area as shown.

3 Feed paper into the manual feeder only to the point where its leading edge can contact the paper guides.

4 Adjust the paper guides to the paper width.

Warning—Potential Damage: Do not force the paper into the feeder. Forcing the paper causes jams.

Using the standard exit bin and paper stop
The standard exit bin holds up to 150 sheets of 20 lb paper. It collects print jobs facedown. The standard exit bin
includes a paper stop that keeps paper from sliding out the front of the bin as it stacks. The paper stop also aids in
neater stacking of the paper.
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To open the paper stop, pull it so it flips forward.

Notes:

• Do not leave the paper stop in the open position if you are printing on transparencies. Doing so may cause
creases in the transparencies.

• When moving the printer to another location, make sure the paper stop is closed.

Linking and unlinking trays

Linking trays
Tray linking is useful for large print jobs or multiple copies. When one linked tray is empty, paper feeds from the next
linked tray. When the Size and Type settings are the same for any trays, the trays are automatically linked. The Size
and Type settings for all trays must be set from the Paper menu.

To initiate tray linking from a locally connected printer:
• On a Windows computer, access the Paper menu through the Local Printer Settings Utility.

• On a Macintosh computer, access the Paper menu through the Printer Settings.

Unlinking trays
Unlinked trays have settings that are not the same as the settings of any other tray. To unlink a tray using the Paper
menu, change the Paper Type and Paper Size settings of that tray so that they do not match the settings of any other
tray.
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To unlink trays from a locally connected printer, do one of the following:

• On a Windows computer, access the Paper menu through the Local Printer Settings Utility. Then, change the
Paper Type and Paper Size settings of the tray so that they do not match the settings of any other tray.

• On a Macintosh computer, access the Paper menu through the Printer Settings. Then, change the Paper Type
and Paper Size settings of the tray so that they do not match the settings of any other tray.

Warning—Potential Damage: Do not assign a Paper Type name that does not accurately describe the type of paper
loaded in the tray. The temperature of the fuser varies according to the specified Paper Type. Paper may not be
properly processed if an inaccurate Paper Type is selected.

Assigning a Custom Type <x> name
Assigning a Custom Type <x> name to a tray enables you to link or unlink it. Use the same Custom Type <x> name
for each tray that you want to link. Only trays with the same custom names assigned will link.

If the printer is connected to a computer by a USB or parallel cable, use one of the following utilities to access the
Paper menu and assign a Custom Type, depending on your operating system:
• On a Windows computer, access the Paper menu through the Local Printer Settings Utility.

• On a Macintosh computer, access the Paper menu through the Printer Settings.

1 Click Settings, and then click Paper Menu.

2 Click Custom Name, and then enter the name for the paper.

3 Click Submit.

4 Select a Custom Type.

5 Verify that the correct Paper Type is associated with the custom name.

Note: Plain Paper is the factory default Paper Type associated with all Custom Type <x> names and user-defined
custom names.

6 Click Submit.
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Paper and specialty media guide

Paper guidelines

Paper capacities
The capacities of the trays and the manual feeder are based on 75 g/m2 (20 lb) paper.

Load up to Notes

Tray 1
250 sheets of paper
150 sheets of A6-size paper
50 paper labels
50 transparencies

Vinyl, pharmacy, or dual-sided labels are not supported. Use paper
labels only. Single-sided paper labels designed for laser printers
are supported for occasional use.

Tray 2
250 or 550 sheets of paper
50 paper labels

Only one optional drawer may be installed on the printer at a time.
The maximum amount of paper that can be loaded depends on
whether you have an optional 250- or 550-sheet tray.

Vinyl, pharmacy, or dual-sided labels are not supported. Use paper
labels only. Single-sided paper labels designed for laser printers
are supported for occasional use.

Manual feeder
1 sheet of paper
1 sheet of A6-size paper
1 transparency
1 sheet of card stock
1 envelope

Feed paper into the manual feeder only to the point where its
leading edge can contact the paper guides. Do not force the paper
into the feeder.

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.

Weight

The printer trays can automatically feed paper weights up to 90 g/m2 (24 lb bond) grain long paper. The manual
feeder can automatically feed paper weights up to 163 g/m2 (43 lb bond) grain long paper. Paper lighter than
60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 75 g/m2 (20 lb
bond) grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 in.), we recommend 90 g/m2 (24 lb) or heavier
paper.

Note: Duplex printing is supported only for 60–90 g/m2 (16–24 lb bond) paper.
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Curl
Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur
after the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in
hot, humid, cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause
feeding problems.

Smoothness
Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If paper is too
smooth, it can cause paper feeding or print quality issues. Always use paper between 100–300 Sheffield points;
smoothness between 150–250 Sheffield points produces the best print quality.

Moisture content
The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.

Condition paper before printing by storing it in its original wrapper in the same environment as the printer for 24 to
48 hours before printing. Extend the time several days if the storage or transportation environment is very different
from the printer environment. Thick paper may also require a longer conditioning period.

Grain direction
Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.

For 60–90 g/m2 (16–24 lb bond) paper, grain long paper is recommended.

Fiber content
Most high-quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper
containing fibers such as cotton can negatively affect paper handling.

Unacceptable paper
The following paper types are not recommended for use with the printer:
• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers,

carbonless copy paper (CCP), or no carbon required (NCR) paper

• Preprinted papers with chemicals that may contaminate the printer

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise print location on the page) greater than ±2.3 mm
(±0.9 in.), such as optical character recognition (OCR) forms

In some cases, registration can be adjusted with a software application to successfully print on these forms.

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough-edged, rough or heavily textured surface papers, or curled papers

• Recycled papers that fail EN12281:2002 (European)

• Paper weighing less than 60 g/m2 (16 lb)

• Multiple-part forms or documents
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Selecting paper
Using appropriate paper prevents jams and helps ensure trouble-free printing.

To help avoid jams and poor print quality:

• Always use new, undamaged paper.

• Before loading paper, know the recommended print side of the paper. This information is usually indicated on
the paper package.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, types, or weights in the same source; mixing results in jams.

• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60 to 90 g/m2 weight paper.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must be able to withstand
temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that are not affected
by the resin in toner. Inks that are oxidation-set or oil-based generally meet these requirements; latex inks might not.
When in doubt, contact the paper supplier.

Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without melting
or releasing hazardous emissions.

Using recycled paper and other office papers
• Low moisture content (4–5%)

• Suitable smoothness (100–200 Sheffield units, or 140–350 Bendtsen units, European)

Note: Some much smoother papers (such as premium 24 lb laser papers, 50–90 Sheffield units) and much rougher
papers (such as premium cotton papers, 200–300 Sheffield units) have been engineered to work very well in
laser printers, despite surface texture. Before using these types of paper, consult your paper supplier.

• Suitable sheet-to-sheet coefficient of friction (0.4–0.6)

• Sufficient bending resistance in the direction of feed

Recycled paper, paper of lower weight (<60 g/m2 [16 lb bond]) and/or lower caliper (<3.8 mils [0.1 mm]), and paper
that is cut grain-short for portrait (or short-edge) fed printers may have lower bending resistance than is required for
reliable paper feeding. Before using these types of paper for laser (electrophotographic) printing, consult your paper
supplier. Remember that these are general guidelines only and that paper meeting these guidelines may still cause
paper feeding problems in any laser printer (for example, if the paper curls excessively under normal printing
conditions).
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Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40%. Most label
manufacturers recommend printing in a temperature range of 18 to 24°C (65 to 75°F) with relative humidity
between 40 and 60%.

• Store paper in cartons when possible, on a pallet or shelf, rather than on the floor.

• Store individual packages on a flat surface.

• Do not store anything on top of individual paper packages.

Supported paper sizes, types, and weights
The following tables provide information on standard and optional paper sources and the types of paper they support.

Note: For an unlisted paper size, select the closest larger listed size.

Paper types and weights supported by the printer
The printer engine and the duplex path support 60–90 g/m2 (16–24 lb) paper weights. The manual feeder supports
60–163 g/m2 (16–43 lb) paper weights.

Paper type 250-sheet standard
tray

250- or 550-sheet
optional tray

Manual feeder Duplex path

Paper
• Plain

• Light

• Heavy

• Rough/Cotton

• Recycled

• Custom

Bond

Letterhead

Preprinted

Colored Paper

Card stock X X X

Glossy paper X X X X

Paper labels1 X

Transparencies X X

Envelopes (smooth)2 X X X

1 Single-sided paper labels designed for laser printers are supported for occasional use. It is recommended to print 20 or
fewer pages of paper labels a month. Vinyl, pharmacy, and dual-sided labels are not supported.
2 Use envelopes that lie flat when individually placed on a table facedown.

Paper and specialty media guide

67
Download from Www.Somanuals.com. All Manuals Search And Download.



Paper sizes supported by the printer

Paper size Dimensions Standard
250-sheet tray

Optional 250-
or 550-sheet
tray

Manual feeder Duplex path

A4 210 x 297 mm
(8.3 x 11.7 in.)

A5 148 x 210 mm
(5.8 x 8.3 in.)

X

A61 105 x 148 mm
(4.1 x 5.8 in.)

X X

Executive 184 x 267 mm
(7.3 x 10.5 in.)

X

Folio 216 x 330 mm
(8.5 x 13 in.)

JIS B5 182 x 257 mm
(7.2 x 10.1 in.)

X

Legal 216 x 356 mm
(8.5 x 14 in.)

Letter 216 x 279 mm
(8.5 x 11 in.)

Oficio (Mexico)2 216 x 340 mm
(8.5 x 13.4 in.)

Statement 140 x 216 mm
(5.5 x 8.5 in.)

X

Universal3 76.2 x 127 mm
(3 x 5 in.) up to
216 x 356 mm
(8.5 x 14 in.)

X

B5 Envelope 176 x 250 mm
(6.9 x 9.8 in.)

X X X

C5 Envelope 162 x 229 mm
(6.4 x 9 in.)

X X X

DL Envelope 110 x 220 mm
(4.3 x 8.7 in.)

X X X

7 3/4 Envelope
(Monarch)

98 x 191 mm
(3.9 x 7.5 in.)

X X X

9 Envelope 98 x 225 mm
(3.9 x 8.9 in.)

X X X

1 A6 is supported only for grain long papers.
2 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.
3If a paper size you want to use is not listed, configure a Universal paper size. For more information, see “Configuring
Universal paper settings” on page 55.
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Paper size Dimensions Standard
250-sheet tray

Optional 250-
or 550-sheet
tray

Manual feeder Duplex path

10 Envelope 105 x 241 mm
(4.1 x 9.5 in.)

X X X

Other Envelope 229 x 356 mm
(9 x 14 in.)

X X X

1 A6 is supported only for grain long papers.
2 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.
3If a paper size you want to use is not listed, configure a Universal paper size. For more information, see “Configuring
Universal paper settings” on page 55.
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Setting up for local printing

Windows®

Some Windows operating systems may already include a printer driver that is compatible with the printer.

Note: Installing custom drivers do not replace the system driver. A separate printer object is created and appears in
the Printers folder.

Operating System: Use this type of cable:

Microsoft® Windows Server 2008

Windows VistaTM

Windows XP

Windows Server 2003

Windows 2000

USB or Parallel

Installing the Printer Drivers
Note: Windows Server 2008, Windows Vista, Windows XP, Windows Server 2003, and Windows 2000 require that you
have administrative access to install printer drivers on your computer.

1 Insert the Drivers and Utilities CD.

The Drivers and Utilities CD launches the installation software automatically.

2 When the Drivers and Utilities CD screen appears, click Personal Installation — Install the printer for use on
this computer only, and then click Next.

3 Select your printer from the drop-down menu.

4 Select Typical Installation (recommended), and then click Install.

5 Click Finish, connect the printer to the computer using a USB or parallel cable, and turn on the printer.

The installation prompts you when the setup is completed.

Installing Additional Printer Drivers
1 Turn on your computer, and insert the Drivers and Utilities CD.

When the Drivers and Utilities CD launches, click Cancel.

2 In Windows Vista (default Start menu):

a Click  Control Panel.

b Click Hardware and Sound.

c Click Printers.

In Windows XP (default Start menu):

a Click Start  Control Panel.

b Double-click Printers and Other Hardware.
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c Double-click Printers and Faxes.

In Windows XP (Classic Start menu): Click Start  Settings  Printers and Faxes.

In Windows Vista (Classic Start menu) and all other Windows versions: Click Start  Settings  Printers.

3 Double-click Add Printer.

The Add Printer Wizard opens.

4 Click Next.

5 Select Local printer attached to this computer, and then click Next.

You are prompted to attach the printer to the computer.

6 Select the port you want your printer to use, and then click Next.

7 Select Have Disk.

8 Browse to your CD drive, and select the correct directory for your operating system.

Note: If you installed the printer drivers from the Drivers and Utilities CD before you connected the printer to
your computer, the PCL-XL driver for your operating system was installed by default.

Operating System Software Path

Windows Server 2008

Windows Vista

Windows XP

Windows Server 2003

Windows 2000

D:\Drivers\Print\Win_2kXP\, where D:\ is the letter of your CD-ROM.

Note: After selecting the directory containing your printer drivers, you may be prompted for additional files in
order to continue installation. Insert the operating system CD, and then click OK.

9 Click Open, and then click OK.

10 Select the type of driver you want to install (PCL, HBP, or PS) in the Manufacturer list, and the printer model in
the Printers list, and then click Next.

11 Proceed through the rest of the Add Printer Wizard, and then click Finish to install the printer driver.

Installing Additional Printer Software
1 Turn on your computer, and insert the Drivers and Utilities CD.

The Drivers and Utilities CD should launch the installation software automatically.

2 Select Additional Software Installation - Install the printer support software, and then click Next.

3 Select the check boxes next to the printer software you want to install, and then click Install.

The software is installed on your computer.
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Macintosh®

Macintosh OS 9 or later is required for USB printing. In order to print to a USB printer, create a Desktop Printer icon
(Mac OS 9), or add the printer in Print Center or Printer Setup Utility (Mac OS X).

Mac OS X: Adding the Printer in Print Center or Printer Setup Utility
1 Install support for the printer on the computer.

a Insert the Drivers and Utilities CD.

b Double-click the installer package for the printer.

c Continue past the Welcome screen and the Read me.

d Click Continue after viewing the license agreement, and then click Agree to accept the terms of the
agreement.

e Select a destination for the installation, and then click Continue.

f Click Install on the Easy Install screen.

g Enter the administrator password, and then click OK.
The software is installed on the computer.

h Quit the installer when it is finished.

2 Open Print Center (10.2) or Printer Setup Utility (10.3+), located in /Applications/Utilities.

3 If the USB printer appears in the Printer List: The printer has been set up successfully, and you can quit the application.

If the USB printer does not appear in the Printer List: Ensure that the USB cable is properly connected between the
printer and the computer and that the printer is turned on. After the printer appears in the Printer List, the printer
has been set up successfully and you can quit the application.

Mac OS 9: Creating a Desktop Printer With Desktop Printer Utility
1 Install support for the printer on the computer.

a Insert the Drivers and Utilities CD.

b Double-click the installer package for the printer.

c Continue past the Welcome screen and the Read me.

d Click Continue after viewing the license agreement, and then click Agree to accept the terms of the
agreement.

e Select a destination for the installation, and then click Continue.

f Click Install on the Easy Install screen.
The software is installed on the computer.

g Quit the installer when it is finished.

2 Open Desktop Printer Utility, usually located in Applications:Utilities.

3 Select Printer (USB), and then click OK.

4 In the USB Printer Selection section, click Change.

If the printer does not appear in the USB Printer Selection list, ensure that the USB cable is properly connected
between the printer and the computer, and that the printer is turned on.
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5 Select the printer, and then click OK.

The printer appears in the Printer (USB) window.

6 In the PostScript Printer Description (PPD) File section, click Auto Setup.

Ensure that the printer PPD matches the printer model.

7 Click Create.

8 Click Save.

9 Enter a name for the printer, and then click OK.

The printer is saved as a Desktop Printer.

Linux®

Local printing is supported on many Linux platforms, such as Red Hat, SUSE, DebianTM GNU/Linux, Ubuntu, Red Flag
Linux, and Linspire.

Printer software packages and installation instructions are available on the Drivers and Utilities CD. All the printer
software supports local printing using a parallel connection.

To launch the installation instructions for Linux:

1 Insert the Drivers and Utilities CD. If the Drivers and Utilities CD automatically launches, click Cancel.

2 Browse to D:\unix\docs\<your language>\index.html, where D:\ is the letter of your CD-ROM drive.
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Software Overview
Use the Drivers and Utilities CD that came with your printer to install a combination of software applications,
depending on your operating system.

Note: If you purchased your printer and computer separately, you must use the Drivers and Utilities CD to install these
software applications.

Note: These software applications are not available with Macintosh®.

Status Monitor Center
Note: For the local Status Monitor Center to work properly, bidirectional communication support must be in place
so the printer and computer can communicate. The Status Monitor Center only works when the printer is connected
to a computer locally through a USB cable.

Use the Status Monitor Center to manage multiple Status Monitors.
• Double-click a printer name to open its Status Monitor, or select Run to open a Status Monitor for a particular

printer.

• Select Update to change the appearance of the list of printers.

Local Printer Settings Utility
Use the Dell Local Printer Settings Utility to change and save printer settings not available from the printer software
(for example, activating Alarm Control if you want the printer to sound an alarm when it needs attention).

Note: The Local Printer Settings Utility only works when the printer is connected to a computer locally through a
USB or parallel cable.

The Dell Local Printer Setup Utility is installed automatically on your computer when you install the printer software.
To access the utility:

1 Insert the Drivers and Utilities CD.

2 Select Additional Software Installation, and then click Next.

3 Select Local Printer Settings Utility, and then click Install.

After you install this utility, you can change settings of such controls as Toner Darkness, Power Saver, Paper Size, and
Paper Type. Once selected, these settings apply to all print jobs, but you can use the printer software to change these
settings for individual print jobs. Save settings from the toolbar by clicking Actions  Apply Settings. You can also
save your settings in a command file to distribute to designated printers by clicking Actions  Save As Command
File.

You can change the following settings using the Dell Local Printer Settings Utility:

• Paper

• Finishing

• Quality

• Setup

• PCL Emulation
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• PostScript

• Parallel

• USB

Paper Finishing Quality Setup

• Paper Source

• Paper Size

• Paper Type

• Custom Types

• Substitute Size

• Paper Texture

• Paper Weight

• Duplex Binding

• Copies

• Blank Pages

• Collation

• Separator Sheets

• Separator Source

• Multipage (pages/side)

• Multipage Ordering

• Orientation

• Multipage Border

• Print Resolution

• Small Font Enhancer

• Toner Darkness

• Picture Grade

• Printer Language

• Jam Recovery

• Display Language

• Print Area

• Alarm Control

• Toner Alarm

• Download Target

• Power Saver

• Print Timeout

• Auto Continue

• Wait Timeout

• Resolution Reduction

• Resource Save

• Reset Control

• Print Buffer Control

• Page Protect

• Eco Mode

• Quiet Mode

PCL Emulation PostScript Parallel USB

• A4 Width

• Orientation

• Auto CR After LF

• Auto LF after CR

• Lines Per Page

• Print PS Error

• Font Priority

• PCL SmartSwitch

• PS SmartSwitch

• Advanced Status

• Honor Init

• Protocol

• Parallel Buffer

• PCL SmartSwitch

• PS SmartSwitch

• USB Buffer

Note: This utility is not supported in Windows x64 environments.

Driver Profiler
Use the Driver Profiler to create driver profiles that contain custom driver settings. A driver profile can contain a group
of saved printer driver settings and other data for such things as:

• Print orientation and N-Up (document settings)

• Installation status of an output tray (printer options)

• User-defined paper sizes (custom papers)

• Simple text and watermarks

• Overlay references
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• Font references

• Form associations

Dell Printer Alert Utility
Note: This application is not available with Windows 2000.

The Dell Printer Alert Utility informs you when there are errors requiring your intervention on your printer. When
there is an error, a bubble appears telling you what the error is, and points you to the appropriate recovery information.

Note: For the Dell Printer Alert Utility to work properly, bidirectional communication support must be in place so the
printer and computer can communicate. An exception is added to the Windows Firewall to allow this communication.

If you opted to install the Dell Printer Alert Utility with your printer software, the utility automatically launches when
the software installation is completed. The utility is active if you see  in the System Tray.

To disable the Dell Printer Alert Utility:

1 From the System Tray, right click the  icon.

2 Select Exit.

To re-enable the Dell Printer Alert Utility:

1 In Windows Vista (default Start menu):

a Click  Programs.

b Click Dell Printers.

c Click Dell 2230d Laser Printer.

In Windows XP and 2000:

Click Start   Programs or All Programs   Dell Printers   Dell 2230d Laser Printer.

2 Click Printer Alert Utility.

Installing the Optional XPS Driver
The XML Paper Specification (XPS) driver is an optional printer driver designed to make use of the advanced XPS
color and graphics features that are only available for Windows Vista users. In order to use XPS features, you must
install the XPS driver as an additional driver after you install your printer.

Note: Before installing the XPS driver, complete the steps on the Setting Up Your Printer poster to install the printer
on your computer.

To install the driver:

1 Click  Control Panel.

2 Under Hardware and Sound, click Printer, and then click Add a Printer.
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3 From the Add Printer dialog box, choose one of the following:

• If you are using a USB connection, make sure the USB cable is connected to the computer and printer, and
then do the following:
a Click Add a local printer.
b From the Use an existing port: drop-down menu, select Virtual printer port for USB, and then click

Next.

4 Click Have disk.

The Install From Disk dialog box opens.

5 Click Browse, and then navigate to the XPS driver files on your computer:

a Click Computer, and then double-click (C:).

b Double-click Drivers, and then double-click PRINTER.

c Double-click the folder that has your printer model number, and then double-click Drivers.

d Double-click xps, and then click Open.

e From the Install From Disk dialog box, click OK.

6 Click Next on the following two dialog boxes.

For more information on the XPS driver, see the XPS readme file on the Drivers and Utilities CD. The file is located in
the xps folder with the setupxps batch file (D:\Drivers\xps\readme).

Dell Toner Management System

Printing Status Window
Note: For the Printing Status Window to work properly, bidirectional communication support must be in place so
the printer and computer can communicate. An exception is added to the Windows® Firewall to allow this
communication.

The Printing Status window displays the status of the printer (Printer Ready, Printer Offline, and Error-Check Printer)
and the name of the job when you send a job to print.

The Printing Status window also displays the level of toner so you can:

• Monitor the toner level for your printer.

• Click Order Supplies to order replacement toner cartridges.

Dell Printer Supplies Reorder Application
The Order Supplies dialog box can be launched from the Printing Status window, the Programs window, or the
desktop icon.

You can order toner by phone or from the Web.

• If ordering online, launch the Dell Printer Supplies Reorder Application:

1 In Windows Vista (default Start menu):
a Click  Programs.
b Click Dell Printers.
c Click Dell 2230d Laser Printer.
In Windows XP and 2000:
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Click Start   Programs or All Programs   Dell Printers   Dell 2230d Laser Printer.

2 Click Dell Printer Supplies Reorder Application.
The Order Supplies dialog box opens.

3 If Multiple Printers Found launches, select the printer you are ordering the supplies for.

4 Follow the instructions on the screen.

• If ordering from the Web, click the link under the Order Online heading.

• If ordering by phone, call the number that appears under the Order by Phone heading.
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Printing
This chapter covers printing, printer reports, and job cancelation. Selection and handling of paper and specialty
media can affect how reliably documents print. For more information, see “Avoiding jams” on page 97 and “Storing
paper” on page 67.

Printing a document
1 Load paper into a tray or feeder.

2 From the Paper menu, set the Paper Type and Paper Size based on the paper that is loaded.

3 Do one of the following:

For Windows users
a With a document open, click File  Print.

b Click Properties, Preferences, Options, or Setup.

c From the Form Source list box, select the source containing the paper you loaded.

d From the Form Type list box, select the paper type.

e From the Form Size list box, select the paper size.

f Click OK, and then click Print.

For Macintosh users
In Mac OS X:

a Customize the settings as needed in the Page Setup dialog.
1 With a document open, choose File > Page Setup.
2 From the Paper Size pop-up menu, choose a paper size or create a custom size to match the loaded paper.
3 Click OK.

b Customize the settings as needed in the Print dialog:
1 With a document open, click File > Print.

If necessary, click the disclosure triangle to see more options.
2 From the print options or Copies & Pages pop-up menu, choose Printer Features.
3 From the Feature Sets pop-up menu, choose Paper.
4 From the Paper type pop-up menu, choose a paper type.
5 Click Print.

In Mac OS 9:

a Customize the settings as needed in the Page Setup dialog:
1 With a document open, choose File > Page Setup.
2 From the Paper pop-up menu, choose a paper size or create a custom size to match the loaded paper.
3 Click OK.
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b Customize the settings as needed in the Print dialog:
1 With a document open, choose File > Print.
2 Select a Paper Source option, and then choose the tray loaded with the appropriate paper.
3 Click Print.

Printing on both sides of the paper
If you want to print two-sided pages for every print job, or for most print jobs, then select Duplex in the Finishing
menu. To access the Finishing menu, do one of the following:
• If the printer is connected to a computer by USB or parallel cable, then open the Local Printer Settings Utility for

Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.

• For occasional two-sided printing, you can request two-sided printing in the printer software. Do one of the
following, depending on your operating system:

For Windows users
1 With a document open, click File  Print.

2 Click Properties, Preferences, Options, or Setup.

3 Under the Page Layout tab, select 2-sided printing (duplex).

4 Select Long edge or Short edge.

5 Click OK.

For Macintosh users
1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.

2 From the print options, Copies & Pages, or General pop-up menu, choose Layout.

3 From the Two-Sided pop-up menu, choose a duplex setting.

4 Click Print.

Setting Jam Recovery
To ensure that a page will reprint after a paper jam, set Jam Recovery to Auto or On.

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows
or Printer Settings for Macintosh. Under the Setup menu, ensure that Jam Recovery is set to Auto or On.
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Printing specialty documents

Tips on using letterhead
Page orientation is important when printing on letterhead. Use the following table to determine which direction to
load the letterhead:

Source or process Print side and paper orientation

• Standard 250-sheet tray

• Optional 250-sheet tray

• Optional 550-sheet tray

Printed letterhead design is placed facedown. The top edge of the sheet with the
logo is placed at the front of the tray.

Duplex (two-sided) printing from
trays

Printed letterhead design is placed faceup. The top edge of the sheet with the logo
is placed at the rear of the tray.

Manual feeder (simplex printing) Preprinted letterhead design is placed faceup. The top edge of the sheet with the
logo should enter the manual feeder first.

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is acceptable for
laser printers.
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Source or process Print side and paper orientation

Manual feeder (duplex printing) Preprinted letterhead design is placed facedown. The top edge of the sheet with the
logo should enter the manual feeder last.

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is acceptable for
laser printers.

Tips on using transparencies
Print samples on the transparencies being considered for use before buying large quantities.

When printing on transparencies:

• Feed transparencies from the standard 250-sheet tray or the manual feeder.

• Use transparencies designed specifically for laser printers. Check with the manufacturer or vendor to ensure that
the transparencies are able to withstand temperatures up to 175° C (350° F) without melting, discoloring,
offsetting, or releasing hazardous emissions.

Note: Transparencies can be printed at a temperature up to 180° C (356° F) if Transparency Weight is set to Heavy
and Transparency Texture is set to Rough. Select these settings in the Paper menu using a local utility.

• To prevent print quality problems, avoid getting fingerprints on the transparencies.

• Before loading transparencies, fan the stack to prevent sheets from sticking together.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.

When printing on envelopes:

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure the
envelopes can withstand temperatures up to 210°C (410°F) without sealing, wrinkling, curling excessively, or
releasing hazardous emissions.

• For the best performance, use envelopes made from 90 g/m2 (24 lb bond) paper. Use up to 105 g/m2 (28 lb bond)
weight for envelopes as long as the cotton content is 25% or less. All-cotton envelopes must not exceed
90 g/m2 (24 lb bond) weight.

• Use only new envelopes.

• To optimize performance and minimize jams, do not use envelopes that:

– Have excessive curl or twist

– Are stuck together or damaged in any way

– Have windows, holes, perforations, cutouts, or embossing

– Have metal clasps, string ties, or folding bars

– Have an interlocking design

– Have postage stamps attached
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– Have any exposed adhesive when the flap is in the sealed or closed position

– Have bent corners

– Have rough, cockle, or laid finishes

• Adjust the width guides to fit the width of the envelopes.

Note: A combination of high humidity (over 60%) and the high printing temperature may wrinkle or seal envelopes.

Tips on using labels
Print samples on the labels being considered for use before buying large quantities.

Note: Use only paper label sheets. Vinyl, pharmacy, and dual-sided labels are not supported.

When printing on labels:
• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:

– The labels can withstand temperatures up to 210°C (410°F) without sealing, excessive curling, wrinkling, or
releasing hazardous emissions.

Note: Labels can be printed at a higher fusing temperature up to 220°C (428°F) if Label Weight is set to
Heavy. Select this setting using the Embedded Web Server, or from the printer control panel Paper menu.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 25 psi (172 kPa) pressure
without delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and cartridge warranties.

• Do not use labels with exposed adhesive.

• Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die-cuts of the label.

• Be sure adhesive backing does not reach to the sheet edge. Zone coating of the adhesive at least 1 mm (0.04 in.)
away from edges is recommended. Adhesive material contaminates the printer and could void the warranty.

• If zone coating of the adhesive is not possible, remove a 1.6 mm (0.06 in.) strip on the leading and driver edge,
and use a non-oozing adhesive.

• Portrait orientation works best, especially when printing bar codes.

Tips on using card stock
Card stock is heavy, single-ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly impact print quality. Print samples on the card stock being considered for use before
buying large quantities.

When printing on card stock:

• Make sure the Paper Type is Card Stock.

• Select the appropriate Paper Texture setting.

• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams or
other paper handling problems.

• Check with the manufacturer or vendor to ensure the card stock can withstand temperatures up to 210°C (410°F)
without releasing hazardous emissions.

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting
introduces semi-liquid and volatile components into the printer.

• Use grain short card stock when possible.
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Printing a booklet
1 Click the Page Layout tab.

2 Click More Page Layout Options.

3 Click Booklet.

4 Click OK.

Notes:

• The booklet feature automatically enables 2-sided printing with short-edge control, so any 2-sided printing
options must be set before selecting the booklet function. After Booklet is selected, the 2-sided printing options
remain at the last setting used.

• Booklet options are unavailable if the duplex unit is installed on the printer but not added to the Installed Options.

Printing information pages

Printing the menu settings page
Print the menu settings page to review the current menu settings and to verify that the printer options are installed
correctly. To print the menu settings:

1 Ensure that the  light is on.

2 Press .

The menu settings page prints.

On the menu settings page:

• Under the Paper Menu, check what papers are listed under Custom Types.

Printing the print quality test pages
Print the print quality test pages to isolate print quality problems.

1 Turn the printer off, and then open the front door.

2 Press and hold  while turning the printer on.

3 Release .

4 Close the front door. The home menu light sequence appears.
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 - On

 - On

 - On

 - On

5 Press and release  until you see the light sequence for print quality test pages, as indicated on the printer
settings configuration page.

6 Press and hold  until all the lights cycle.

After a few minutes, the print quality test pages print. The pages include:
• An information page that contains information about the printer, the toner cartridge, the margin settings,

and the minimum stroke width, and a graphic for evaluating the print quality

• Two pages to evaluate how well the printer is capable of printing various types of graphics

7 Examine the pages to determine the quality of printing. If there are problems, see “Solving print quality problems”
on page 114.

To return to the home menu, press and hold  until all the lights cycle. To exit the menus, turn the printer off.

Canceling a print job
To cancel a print job, do one of the following:

From the printer control panel
1 Press  to cancel the current print job.

2 Wait for the  light to appear before re-sending the print job.

For Windows users
In Windows Vista:

1 Click .

2 Click Control Panel.

3 Click Hardware and Sound.

4 Click Printers.

5 Double-click the printer icon.

6 Select the job to cancel.

7 From the keyboard, press Delete.

In Windows XP:

1 Click Start.

2 From Printers and Faxes, double-click the printer icon.

3 Select the job to cancel.

4 From the keyboard, press Delete.
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From the Windows taskbar:

When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon.

A list of print jobs appears in the printer window.

2 Select a job to cancel.

3 From the keyboard, press Delete.

For Macintosh users
In Mac OS X version 10.5:

1 From the Apple menu, choose System Preferences..

2 Click Print & Fax, and then double-click the printer you are printing to.

3 From the printer window, select the job to cancel.

4 From the icon bar at the top of the window, click the Delete icon.

In Mac OS X versions 10.2 through 10.4:

1 Choose Applications > Utilities, and then double-click Print Center or Printer Setup Utility.

2 Double-click the printer icon.

3 From the printer window, select the job to cancel.

4 From the icon bar at the top of the window, click the Delete icon.

In Mac OS 9:

When you send a job to print, the printer icon for your selected printer appears on the desktop.

1 Double-click the printer icon.

2 From the printer window, select the job to cancel.

3 Click the trash icon.
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Maintaining the printer
Periodically, certain tasks are required to maintain optimum print quality.

Ordering supplies

Printer attached locally to a computer
1 In Windows Vista® (default Start menu):

a Click  Programs.

b Click Dell Printers.

c Click Dell 2230d Laser Printer.

In Windows® XP and 2000:

Click Start   Programs or All Programs   Dell Printers   Dell 2230d Laser Printer.

2 Click Dell Printer Supplies Reorder Application.

The Order Supplies window opens.

3 Click the link under the Order Online heading.

Cleaning the exterior of the printer
1 Make sure that the printer is turned off and unplugged from the wall outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer,
unplug the power cord from the wall outlet and disconnect all cables to the printer before proceeding.

2 Remove all paper from the printer.

3 Dampen a clean, lint-free cloth with water.

Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the finish of
the printer.

4 Wipe only the outside of the printer.

Warning—Potential Damage: Using a damp cloth to clean the interior may cause damage to your printer.

5 Make sure all areas of the printer are dry before beginning a new print job.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until
you are ready to use them.

Do not expose supplies to:

• Direct sunlight

• Temperatures above 35°C (95°F)
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• High humidity above 80%

• Salty air

• Corrosive gases

• Heavy dust

Conserving supplies

Conserving supplies using the printer menus
There are some settings you can change in the printer menus that will help you conserve toner and paper.

If the printer is connected to the computer by a USB or parallel cable, open the Local Printer Settings Utility for
Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.

Supply Path to menu item Purpose of menu item

Toner From the Quality menu, you can adjust
the Toner Darkness setting.

Lets you adjust the level of toner
released on a sheet of paper or specialty
media. The values range from 1 (lightest
setting) to 10 (darkest setting) with 8
being the factory default setting.

Paper or specialty media From the Finishing menu, you can
adjust the N-up (Multipage Print)
setting.

Lets you print two or more page images
on one side of a sheet. Values for N-up
are 2-Up, 3-Up, 4-Up, 6-Up, 9-Up, 12-Up,
and 16-Up.

From the Finishing menu, you can
select Duplex.

Lets you print on both sides of a sheet
of paper

Conserving supplies when printing multiple copies
If you need to print several copies, you can conserve supplies by printing the first copy and checking it for accuracy
before printing the remaining copies.

Extending the life of your toner cartridge
When the “Toner is low” light sequence appears or when the print becomes faded, you may be able to extend the
life of the toner cartridge:

1 Remove the toner cartridge. For more information, see “Replacing the toner cartridge” on page 89.

2 Firmly shake the cartridge side-to-side and front-to-back several times to redistribute toner.
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3 Reinsert the cartridge, and continue printing.

Note: Repeat this procedure multiple times until the print remains faded, and then replace the cartridge.

Replacing supplies

Replacing the toner cartridge

Light sequence
Toner is low

 - On

 - On

When the “Toner is low” light sequence appears or when you experience faded print, remove the toner cartridge.
Firmly shake it side-to-side and front-to-back several times to redistribute the toner, and then reinsert it and continue
printing. When shaking the cartridge no longer improves the print quality, replace the toner cartridge.

Note: You can estimate how much toner is left in your cartridge by printing a menu settings page. For more
information, see “Printing the menu settings page” on page 84.

To replace the toner cartridge:

1 Open the front door by pressing the button on the left side of the printer and lowering the door.
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2 Press the button on the base of the photoconductor kit, and then pull the toner cartridge out using the handle.

3 Unpack the new toner cartridge.

Warning—Potential Damage: When replacing a toner cartridge, do not leave the new cartridge exposed to
direct light for an extended period of time. Extended light exposure can cause print quality problems.

4 Shake the cartridge in all directions to distribute the toner.

5 Install the new toner cartridge by aligning the rollers on the toner cartridge with the arrows on the tracks of the
photoconductor kit. Push the toner cartridge in as far as it will go. The cartridge clicks into place when correctly
installed.

6 Close the front door.

Maintaining the printer

90
Download from Www.Somanuals.com. All Manuals Search And Download.



Replacing the photoconductor kit
The printer notifies you when the photoconductor kit reaches a page maximum. The printer does this by displaying
the “Photoconductor life warning” light sequence or the “Replace photoconductor” light sequence.

Light sequences
Photoconductor life warning

 - Blinking

 - On

Replace photoconductor

 - Blinking

 - Blinking

 - On

When you first receive either light sequence, you should immediately order a new photoconductor kit. While the
printer may continue to function properly after the photoconductor kit has reached its official end-of-life, print quality
significantly decreases.

Note: The photoconductor kit is one item only.
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To replace the photoconductor kit:

1 Open the front door by pressing the button on the left side of the printer and lowering the front door.

2 Pull the photoconductor kit and toner cartridge together as a unit out of the printer by pulling on the toner
cartridge handle.

Note: The photoconductor kit and toner cartridge form a unit.

Place the unit on a flat, clean surface.

3 Press the button on the base of the photoconductor kit. Pull the toner cartridge up and out using the handle.

4 Unpack the new photoconductor kit.

Warning—Potential Damage: Be careful not to touch the photoconductor drum. Doing so may affect the print
quality of future print jobs.
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5 Insert the toner cartridge into the photoconductor kit by aligning the rollers on the toner cartridge with the tracks.
Push the toner cartridge in until it clicks into place.

6 Install the unit into the printer by aligning the arrows on the guides of the unit with the arrows in the printer.
Push the unit as far as it will go.

7 After you replace the photoconductor kit, reset the photoconductor counter. To reset the counter, see the
instruction sheet that came with the new photoconductor kit.

Warning—Potential Damage: Resetting the photoconductor counter without replacing the photoconductor
kit may damage your printer and void your warranty.

8 Close the front door.
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Moving the printer

Before moving the printer
CAUTION—POTENTIAL INJURY: Follow these guidelines to avoid personal injury or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off of the optional drawer and set it aside instead of trying to lift the drawer and printer at the
same time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.

• Make sure your fingers are not under the printer when you set it down.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.

Moving the printer to another location
CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal injury
or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off of the optional drawer and set it aside instead of trying to lift the drawer and printer at the
same time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.

The printer and options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer. Any cart
used to move the options must have a surface able to support the dimensions of the options.

• Keep the printer in an upright position.

• Avoid severe jarring movements.
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Setting the printer up in a new location
When the printer is set up, allow clearance around it as shown.

1 300 mm (12.0 in.)

2 300 mm (12.0 in.)

3 200 mm (8.0 in.)

4 12.7 mm (0.5 in.)

5 300 mm (12.0 in.)

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Administrative support

Adjusting Power Saver
Increase or decrease the number of minutes before the printer enters Power Saver mode.

If your printer is connected to a computer by a USB or parallel cable, use the Local Printer Settings Utility for Windows
or Printer Settings for Macintosh.

1 Click Setup.

2 Ensure that the Power Saver check box is selected.

3 Clicking the small arrow buttons, increase or decrease the number of minutes before the printer enters Power
Saver mode. Available settings range from 1–240 minutes.

4 From the menu bar, click Actions  Apply Settings.

Restoring the factory default settings
If your printer is connected to a computer by a USB or parallel cable, use the Local Printer Settings Utility for Windows
or Printer Settings for Macintosh.

1 Open the utility.

2 Do one of the following:

• From the Local Printer Settings Utility menu bar, click Actions  Restore Factory Defaults.

• From Printer Settings, click Factory Defaults.

Warning—Potential Damage: Restore Factory Defaults returns all printer settings to the factory default settings
except the Port menu settings. All downloads stored in RAM are deleted.

You can also restore factory default settings using the printer control panel. For instructions, print a printer settings
configuration sheet.
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Clearing jams

Avoiding jams
The following hints can help you avoid jams:

• Use only recommended paper or specialty media. For more information, see “Paper and specialty media guide”
on page 64.

• Do not load too much paper. Make sure the stack height does not exceed the indicated maximum height.

• Do not load wrinkled, creased, damp, or curled paper.

• Flex, fan, and straighten paper before loading it.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, weights, or types in the same stack.

• Store the paper in an appropriate environment.

• Do not remove trays while the printer is printing. Wait for the  light to come on before removing a tray. The
light sequence for loading paper also signals that the tray may be removed:

Load paper

 - On

• Do not load the manual feeder while the printer is printing. Wait for the  light to come on.

• Push all trays in firmly after loading paper.

• Make sure the guides in the trays are properly positioned, and are not pressing too tightly against the paper.

• Make sure all paper sizes and paper types are set correctly.

• Make sure all printer cables are attached correctly. For more information, see the setup documentation.
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Accessing jam areas
Open doors and remove trays to access jam areas. The following illustration shows possible jam areas:

Access point Description

1 Push button to open the front door. Inside this door is the unit housing the toner cartridge and
photoconductor kit.

2 Standard exit bin

3 Front door

4 Manual feeder door

5 Standard 250-sheet tray (Tray 1)

6 Optional tray (Tray 2)

7 Rear door

Understanding jam lights and access locations
The following table lists the jam lights and messages and provides brief instructions for how to access each jam. More
detailed instructions follow.

200.yy Paper jam

 - On

 - On

 - On
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Try one of the following:

• Remove Tray 1.

• Open the front door, and then remove the photoconductor kit and toner cartridge unit.

201.yy Paper jam

 - On

 - On

 - On

Open the front door, and then remove the photoconductor kit and toner cartridge unit.

202.yy Paper jam

 - On

 - On

 - On

Open the front door, and then open the rear door.

231.yy Paper jam
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 - On

 - Blinking

 - On

Open the front door, and then open the rear door.

233.yy Paper jam

 - On

 - Blinking

 - Blinking

 - On

Try one of the following:

• Remove Tray 1.

• Open the front door, and then open the rear door.

234.yy Paper jam

 - On

 - Blinking

 - On

Try one of the following:

• Open the front door, and then open the rear door.

• Remove Tray 1.
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235.yy Paper jam

 - On

 - Blinking

 - Blinking

 - On

Remove the jam from the standard exit bin.

24x.yy Paper jam

 - On

 - On

 - On

 - On

Try one of the following:
• Remove Tray 1.

• Open the front door, and then remove the photoconductor kit and toner cartridge unit.

• Remove Tray 2.
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251.yy Paper jam

 - On

 - On

 - On

 - On

Remove the jam from the manual feeder.

Clearing jams behind the photoconductor kit and
toner cartridge
1 Push the release button, and then lower the front door.
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2 Lift and pull the unit containing the photoconductor kit and the toner cartridge out of the printer. Set the unit
aside on a flat, clean surface.

Warning—Potential Damage: Do not touch the photoconductor on the underside of the photoconductor kit.
Use the cartridge handle whenever you are holding the cartridge.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

3 Remove the jammed paper.

Note: If the paper is not easy to remove, then open the rear door to remove the paper.

4 Align and reinstall the unit.

5 Close the front door.

6 Press  to continue printing.
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Clearing jams from the standard exit bin
A paper size that is not supported for duplex printing can jam the standard exit bin.

To remove the jam, gently pull the sheet straight out of the standard exit bin.

Clearing jams from Tray 1
To see whether paper is jammed in or behind Tray 1, the standard tray:

1 Remove Tray 1.
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2 Remove the jammed paper.

3 If necessary, depress the lever to free the paper and remove the jam.

4 Insert the tray.

5 Press  to continue printing.
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Clearing jams from Tray 2
To see whether paper is jammed in or behind Tray 2:

1 Remove Tray 2.

2 Remove the jammed paper.
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3 Insert the tray.

4 Press  to continue printing.

Clearing jams in the manual feeder

Paper jammed in the manual feeder can usually be grasped and pulled straight out. If the jam cannot be removed
this way, check for jammed paper behind the photoconductor kit and toner cartridge unit. For more information,
see “Clearing jams behind the photoconductor kit and toner cartridge” on page 102.
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Clearing jams behind the rear door
If the paper is exiting the printer, pull the paper out. If the paper is not exiting the printer:

1 Push the release button, and then lower the front door.

2 Pull open the rear door.

The paper may be jammed with one end caught in the standard exit bin.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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3 Remove the jammed paper.

4 Close both the front and rear doors.

5 Press  to continue printing.
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Troubleshooting

Solving basic printer problems
If there are basic printer problems, or the printer is unresponsive, ensure the following:

• The power cord is plugged into the printer and a properly grounded electrical outlet.

• The electrical outlet is not turned off by any switch or breaker.

• The Ground Fault Circuit Interrupter (GFCI) has not tripped.

• The printer is not plugged into any surge protectors, uninterrupted power supplies, or extension cords.

• Other electronic equipment plugged into the outlet is working.

• The printer is turned on. Check the printer power switch.

• The printer cable is securely attached to the printer and the host computer, print server, or option.

• All options are properly installed.

• The printer driver settings are correct.

Once you have checked each of these possibilities, turn the printer off, wait for about 10 seconds, and then turn the
printer back on. This often fixes the problem.

Solving printing problems

Jobs do not print
Try one or more of the following:

VERIFY THAT THE PRINTER IS READY TO PRINT

Ensure that the  light is on before sending a job to print.

CHECK TO SEE IF THE STANDARD EXIT BIN IS FULL

Remove the stack of paper from the standard exit bin.

CHECK TO SEE IF THE TRAY IS EMPTY

Load paper in the tray.

ENSURE THAT YOU ARE USING A RECOMMENDED USB OR PARALLEL CABLE

For more information, contact Dell at support.dell.com.

ENSURE THAT THE PRINTER CABLES ARE SECURELY CONNECTED

Check that the cables are firmly connected to the printer. For more information, see the setup documentation that
came with the printer.
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Multiple-language PDFs do not print
The documents contain unavailable fonts.

1 Open the document you want to print in Adobe Acrobat.

2 Click the printer icon.

The Print dialog appears.

3 Select Print as image.

4 Click OK.

Job takes longer than expected to print
The job is too complex.

Reduce the complexity of your print job by eliminating the number and size of fonts, the number and complexity of
images, and the number of pages in the job.

Job prints from the wrong tray or on the wrong paper
Try one or more of the following:

CHECK THE PAPER SIZE AND PAPER TYPE SETTINGS

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for
Windows or Printer Settings for Macintosh.

From the Paper menu, ensure that the Paper Size and Paper Type settings match the paper loaded in the trays.

CHECK THE PAPER TAB SETTINGS IN YOUR OPERATING SYSTEM

Open Print Properties in a Windows operating system or the print dialog in a Macintosh operating system. Ensure
that the input options settings for Paper Size, Paper Tray, and Paper Type correspond with the paper loaded in the
tray.

Incorrect characters print

Hex Trace mode

 - Slowly blinking
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Make sure the printer is not in Hex Trace mode. If the “Hex Trace mode” light sequence appears, you must exit Hex
Trace mode before you can print your job. To exit Hex Trace mode, turn the printer off and back on.

Tray linking does not work
Make sure to do all of the following:
• Load both Tray 1 and Tray 2 with the same paper size and type.

• From Print Properties or the print dialog, change the Paper source to Automatically select.

Large jobs do not collate
Try one or more of the following:

CHECK THE COLLATE SETTING

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for
Windows or Printer Settings for Macintosh.

From the Finishing menu, ensure that Collate is On. To access the Finishing menu, do one of the following:

CHECK THE PAPER TAB SETTINGS IN YOUR OPERATING SYSTEM

Open Print Properties in a Windows operating system or the print dialog in a Macintosh operating system. Ensure
that the “Page layout” setting for “Collate copies” is On, or that the Collate check box is selected.

Note: Clearing the Collate check box overrides the setting in the Finishing menu.

REDUCE THE COMPLEXITY OF THE PRINT JOB

Reduce the complexity of the print job by eliminating the number and size of fonts, the number and complexity
of images, and the number of pages in the job.

ENSURE THAT THE PRINTER HAS ENOUGH MEMORY

Add printer memory. For more information, see “Installing a memory card” on page 34.

Solving option problems

Option does not operate correctly or quits after it is installed
These are possible solutions. Try one or more of the following:

RESET THE PRINTER

Turn the printer off, wait for about 10 seconds, and then turn the printer on.
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CHECK TO SEE IF THE OPTION IS CONNECTED TO THE PRINTER

1 Turn the printer off.

2 Unplug the printer.

3 Check the connection between the option and the printer.

MAKE SURE THE OPTION IS INSTALLED

Print a menu settings page and check to see if the option is listed in the Installed Options list. If the option is not
listed, reinstall it.

MAKE SURE THE OPTION IS SELECTED

From the program you are using, select the option. Mac OS 9 users should make sure the printer is set up in the
Chooser.

Drawers
These are possible solutions. Try one or more of the following:

MAKE SURE THE PAPER IS LOADED CORRECTLY

1 Pull the tray completely out.

2 Check for paper jams or misfeeds.

3 Make sure the guides are aligned against the edges of the paper.

4 Insert the tray.

RESET THE PRINTER

Turn the printer off, wait about 10 seconds, and then turn the printer on.

Memory card
Make sure the memory card is securely connected to the printer system board.

Solving paper feed problems

Paper frequently jams
Try one or more of the following:

CHECK THE PAPER
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FLEX, FAN, AND STRAIGHTEN THE PAPER BEFORE LOADING IT IN THE TRAY

ENSURE THAT THERE IS NOT TOO MUCH PAPER IN THE TRAY

The stack of paper you load must not exceed the maximum stack height indicated in the tray.

CHECK THE GUIDES

Move the guides in the tray to the correct positions for the paper size loaded.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

Paper jam lights remain on after jam is cleared
The paper path is not clear. Clear jammed paper from the entire paper path, and then close any open doors.

Page that jammed does not reprint after the jam is cleared
Jam Recovery is set to Off.

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows
or Printer Settings for Macintosh. From the Setup menu, ensure that Jam Recovery is set to Auto or On.

Solving print quality problems
The information in the following topics may help you solve print quality problems. If these suggestions still do not
correct the problem, call Customer Support. You may have a printer part that requires adjustment or replacement.

Isolating print quality problems
Print the print quality test pages to isolate print quality problems.

1 Turn the printer off, and then open the front door.

2 Press and hold  while turning the printer on.

3 Release .
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4 Close the front door. The light sequence that represents the Home menu appears.

 - On

 - On

 - On

 - On

5 Press and release  until you see the light sequence for print quality test pages, as indicated on the printer
settings configuration sheet.

6 Press and hold  until all lights cycle.

After a few minutes, the print quality test pages print. The pages include:

• An information page containing information about the device, the cartridge, margin settings, and minimum
stroke width, and a graphic for evaluating the print quality

• Two pages for assessing how well the printer is capable of printing various types of graphics

7 Examine the pages to determine the quality of printing. If there are problems, see “Solving print quality problems”
on page 114.

To return to the Home menu, press and hold  until all the lights cycle. To exit the menus, turn the printer off.

Blank pages

Try one or more of the following:

• Remove and reinstall the toner cartridge.

• Remove and reinstall the photoconductor kit.

If the printer still prints blank pages, it may need to be serviced. For more information, contact Customer Support.
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Characters have jagged or uneven edges

If you are using downloaded fonts, verify that the fonts are supported by the printer, the host computer, and the
software program.

Clipped images
Try one or more of the following:

CHECK THE PAPER GUIDES

Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER SIZE SETTING

Ensure that the Paper Size setting matches the paper loaded in the tray.

Gray background

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows
or Printer Settings for Macintosh.

From the Quality menu, select a reduced Toner Darkness setting before sending the job to print.

Ghost images

Try one or more of the following:
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THE PHOTOCONDUCTOR KIT MAY BE DEFECTIVE

Replace the photoconductor kit. For more information, see “Replacing the photoconductor kit” on page 91.

CHECK THE PAPER SIZE AND PAPER TYPE SETTINGS

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for
Windows or Printer Settings for Macintosh.

From the Paper menu, change the paper size and paper type settings to match the paper loaded in the tray.

Incorrect margins

CHECK THE PAPER GUIDES

Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER SIZE SETTING

Make sure the Paper Size setting matches the paper loaded in the tray.

CHECK THE PAGE SIZE SETTING

Before sending the job to print, specify the correct page size in Print Properties or the software program.

Paper curl
Try one or more of the following:

CHECK THE PAPER TYPE SETTING

Ensure that the Paper Type setting matches the paper loaded in the tray.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

Try one or more of the following:

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.
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Print is too dark

Try one or more of the following:

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS

The Toner Darkness setting is too dark, the Brightness setting is too dark, or the Contrast setting is too high.
• From Print Properties, change these settings.

Note: This solution applies to Windows users only.

• From the Quality menu, change these settings.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

CHECK THE PAPER

Avoid textured paper with rough finishes.

CHECK THE PAPER TYPE SETTING

Ensure that the Paper Type setting matches the paper loaded in the tray.

THE TONER CARTRIDGE MAY BE DEFECTIVE

Replace the toner cartridge. For more information, see “Replacing the toner cartridge” on page 89.

Print is too light

Try one or more of the following:
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CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS

The Toner Darkness setting is too light, the Brightness setting is too light, or the Contrast setting is too low.

• From Print Properties, change these settings.

Note: This solution applies to Windows users only.

• From the Quality menu, change these settings.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

CHECK THE PAPER

Avoid textured paper with rough finishes.

CHECK THE PAPER TYPE SETTING

Ensure that the Paper Type setting matches the paper loaded in the tray.

THE TONER MAY BE LOW

When the toner is low light sequence appears or when the print becomes faded, order a new toner cartridge.

THE TONER CARTRIDGE MAY BE DEFECTIVE

Replace the toner cartridge. For more information, see “Replacing the toner cartridge” on page 89.

Skewed print

CHECK THE PAPER GUIDES

Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER

Make sure you are using paper that meets the printer specifications.

Toner fog or background shading appears on the page
Try one or more of the following:

THE TONER CARTRIDGE MAY BE DEFECTIVE

Replace the toner cartridge. For more information, see “Replacing the toner cartridge” on page 89.

THERE IS TONER IN THE PAPER PATH

Contact Customer Support.
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Toner rubs off

Try one or more of the following:

CHECK THE PAPER TYPE SETTING

Ensure that the Paper Type setting matches the paper loaded in the tray.

CHECK THE PAPER TEXTURE SETTING

Ensure that the Paper Texture setting matches the paper loaded in the tray.

Toner specks

Try one or more of the following:

THE TONER CARTRIDGE MAY BE DEFECTIVE

Replace the toner cartridge. For more information, see “Replacing the toner cartridge” on page 89.

THERE IS TONER IN THE PAPER PATH

Contact Customer Support.

Transparency print quality is poor

CHECK THE TRANSPARENCIES

Use only the recommended transparencies. For more information, see “Tips on using transparencies” on
page 82.

CHECK THE PAPER TYPE SETTING

Load the transparencies, and ensure that the Paper Type setting is set to Transparency.
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Streaked horizontal lines

Try one or more of the following:

THE TONER MAY SMEAR WHEN PAPER IS FED FROM A SPECIFIC SOURCE

From Print Properties, the print dialog, or the printer control panel, select another tray or feeder to feed the paper
for the job.

THE TONER CARTRIDGE MAY BE DEFECTIVE

Replace the toner cartridge. For more information, see “Replacing the toner cartridge” on page 89.

ENSURE THAT THE PAPER PATH IS CLEAR

Paper could be caught between the photoconductor kit and the fuser. Check the paper path around the fuser area.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

Clear any paper you see.

THERE MAY BE EXCESS TONER IN THE PAPER PATH

Contact Customer Support.

Streaked vertical lines

Try one or more of the following:

THE TONER MAY SMEAR WHEN PAPER IS FED FROM A SPECIFIC SOURCE

From Print Properties, the Print dialog, or the printer control panel, select another tray or feeder to feed paper for
the job.
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THE TONER CARTRIDGE IS DEFECTIVE

Replace the toner cartridge. For more information, see “Replacing the toner cartridge” on page 89.

ENSURE THAT THE PAPER PATH IS CLEAR

Paper could be caught between the photoconductor kit and the fuser. Check the paper path around the fuser area.

Warning—Potential Damage: Do not touch the photoconductor on the underside of the photoconductor kit.
Use the cartridge handle whenever you are holding the cartridge.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

Clear any paper you see.

THERE MAY BE EXCESS TONER IN THE PAPER PATH

Contact Customer Support.

Solid black or white streaks appear on transparencies or paper

Try one or more of the following:

ENSURE THAT THE FILL PATTERN IS CORRECT

If the fill pattern is incorrect, choose a different fill pattern from your software program.

CHECK THE PAPER TYPE

• Try a different type of paper.

• Use only the recommended transparencies.

• Ensure that the Paper Type setting matches what is loaded in the tray or feeder.

• Ensure that the Paper Texture setting is correct for the type of paper or specialty media loaded in the tray or
feeder.

ENSURE THAT THE TONER IS DISTRIBUTED EVENLY WITHIN THE TONER CARTRIDGE

Remove the toner cartridge and shake it from side to side to redistribute the toner and to extend the life of the
cartridge, and then reinstall it.
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THE TONER CARTRIDGE MAY BE DEFECTIVE OR LOW ON TONER

Replace the used toner cartridge with a new one. For more information, see “Replacing the toner cartridge” on
page 89.

Troubleshooting

123
Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix

Dell Technical Support Policy
Technician-assisted technical support requires the cooperation and participation of the customer in the
troubleshooting process and provides for restoration of the Operating System, application software and hardware
drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality
of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical
support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for
third-party software and peripherals is provided by the original manufacturer, including those purchased and/or
installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Contacting Dell
You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, and
fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

• World Wide Web

www.dell.com/

www.dell.com/ap/ (Asian/Pacific countries only)

www.dell.com/jp/ (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la/ (Latin American and Caribbean countries)

www.dell.ca (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your email address as your password.

• Electronic Support Service

mobile_support@us.dell.com

support@us.dell.com

la-techsupport@dell.com (Latin America and Caribbean countries only)

apsupport@dell.com (Asian/Pacific countries only)

support.jp.dell.com (Japan only)

support.euro.dell.com (Europe only)

• Electronic Quote Service

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)
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Warranty and Return Policy
Dell Inc. (“Dell”) manufactures its hardware products from parts and components that are new or equivalent to new
in accordance with industry-standard practices. For information about the Dell warranty for your printer, refer to the
Product Information Guide.
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